
<br>

Do not open the Seal of the Question Booklet until you are asked to

<br>

Question Booklet Code:

<br>

Time Allowed: 150 Minutes

<br>

C

<br>

Question Booklet Series No:

<br>

Total Questions: 150

<br>

Maximum Marks: 150

<br>

There shall be negative marking @0.25 mark per gquestion for wrong/multiple answers

<br>

Berore answering any question, check the booklet that it contains 24 pages and no page is missing

<br>

mutilated or repeated. In case of defect, get it replaced immediately.

<br>

INSTRUCTIONS FOR CANDIDATES

<br>

ALNK-2024

<br>

I. Fill in the OMR answer sheet, mentioning your Roll No. and other data as reguired in the place(s)

<br>

indicated therein. Darken the appropriate circles in blue or black ball point pen only. Do not write any

<br>

name / surname or put any symbol, sign, slogan, prayer or any mark of identification in the OMR

<br>

answer sheet. Do not tamper with the bar-code or any other portion of the OMR answer sheet. Any

<br>

such act is liable to render the answer sheet unfit for evaluation.

<br>

2. Correcting fluid, eraser, blade, books, textual material, script notes / loose paper, calculatnr

<br>

document, slide rules, log tables/ electronic watches, smart watch, cell phone,pager, other ele

<br>

electronic devices etc, are not allowed inside the examination hall. In case the candidate is fo

<br>

be in possession of any of the above, he / she shall be expelled from the examination withc

<br>

enquiry as to whether the same was/ were used by the candidate or not.

<br>

3. A machine will read the coded information furnished by you in the OMR Answer Shéet. If the

<br>

information so furnished by you is incomplete or different from what you have given in the application

<br>

form, you shallbe awarded Zero mark.

<br>

SEAL

<br>

4. Answer must be given by completely darkening one of the four circles / ovals representing the most

<br>

appropriate answer given on the Answer Sheet corresponding to the relevant question. For answers

<br>

not shown by properly darkening in black/ blue ball point pen, no marks shall be awarded.

<br>

5. No Rough work should be done on the OMR Answer Sheet. Space for rough work has been provided

<br>

in the Question Booklet itself.

<br>

6. After the examination is over, candidates must ensure to fold the OMR Answer Sheet at the

<br>

perforation and separate the Original Copy and Candidate's Copy of the Two Part OMR Answer Sheet

<br>

in the presence of the invigilator and handover the Original Copy to the Invigilator. The Candidate's

<br>

Copy.of the OMR Answer sheet may be taken by the candidate. Failure to hand over the original copy

<br>

of the OMRAnswer Sheet to the Invigilator before leaving the examination hall /room shall make the

<br>

candidate liable for penal action.

<br>

7. Candidates may take with them the respective question-booklet after the examination is over.

<br>

9. Each question has four options. The candidate should select best option among the four.

<br>

8. Failure to comply with or violation of any of the above instructions shallbe considered as adopting

<br>

unfair means and action as deemed proper shall be taken.

<br>

ALNK-ENG-C-1

<br>

https://applink.adda247.com/d/XhqWf9lSap


1. What is the next number in the series: 1, 1, 2,

<br>

3, 5,8,

<br>

a) 10

<br>

b) 11

<br>

CX12

<br>

y 13

<br>

15?

<br>

2. What arethe missingnumbers in this

<br>

series: 15, 20, 24, 15, 28, 32, 15,12

<br>

a) 36,40

<br>

b) 37, 41

<br>

c) 38, 42

<br>

d) 40, 44

<br>

3. Find the missing letters in the series: CKDL,

<br>

KKLL.

<br>

a) IJL

<br>

EKFL, GKHL,

<br>

b) TKJL

<br>

(2

<br>

c) MNOP

<br>

LOGICAL REASONING

<br>

d) MNPQ

<br>

4. If ACID is written as 1C3D, PAMPER is

<br>

written as P1MP2R, then howwill

<br>

BOMBAY be written?

<br>

a) B4MBIY

<br>

b) B3MB1Y

<br>

c) BSMB2Y

<br>

d) B4MB2Y

<br>

B

<br>

5. Find the correct option for the blank spaces.

<br>

J

<br>

N

<br>

a) 18, 23

<br>

b) 14, 19

<br>

c) 16, 21

<br>

d) 15, 20

<br>

6

<br>

14

<br>

8

<br>

17

<br>

D

<br>

M

<br>

S

<br>

6. Consider the following words translated

<br>

from an artificial language.

<br>

•moolokarn means blue sky,

<br>

• wilkdspadi means bicycle race.

<br>

• moolówilko means blue bicycle.

<br>

DHB

<br>

Which of the wordin the optionsgiven below

<br>

could mean "racecar" ?

<br>

a) wilkozwet

<br>

b) spadiwilko

<br>

c) moolobreil

<br>

d)spadivolo

<br>

7. A has two children B and C. B is married to

<br>

D and they have a daughter E. If F is the

<br>

brother of D, then how is F related to A 2

<br>

a) Son-in-law

<br>

b) Brother-in-law

<br>

c) Nephew

<br>

d) Cousin

<br>

)8. If'air' is called 'green', 'green' is called 'red'.

<br>

'red' is called sea', 'sea' is called 'blue?.

<br>

'blue' is called water' and water is called

<br>

'pink', then what is the colour of grass ?

<br>

a) Green

<br>

b) Blue

<br>

c) ·Pink

<br>

9. Arrange the following words in a meaningful

<br>

sequence.

<br>

Red

<br>

1. Selection 2. Probation 3. Appointment

<br>

4. Interview 5. Application 6. Advertisement

<br>

ay6,5,4, 1,3,2

<br>

b) 5,2,4,3, 1, 6

<br>

c) 5,2,4, 1,3, 6

<br>

d) 6,5,4,3, 1, 2

<br>

10. An accurate clock shows 10 o'clock in the

<br>

morning. Through how many degrees will the

<br>

hour hand rotate when the clock shows 6

<br>

o'clock in the evening ?

<br>

a) 180°

<br>

12
19

<br>

b) 190°

<br>

c) 220°

<br>

d)40°

<br>

nsa

<br>

11.If every second Saturday and all Sundays

<br>

are holidays in a 30 days month beginning

<br>

Saturday, then how many working

<br>

'ys are here in that month ?

<br>

2A0

<br>

24

<br>

ALNK-ENG-C-2

<br>

https://applink.adda247.com/d/XhqWf9lSap


c) 22

<br>

d) 20

<br>

12.A sales executive went to meet his client A in

<br>

another office 17 km away in the North-east

<br>

direction of his own office. From there, he went

<br>

to see client B in an office 15 km in the south of

<br>

his client A's office. How far from the starting

<br>

point and in what direction is he now?

<br>

a) 8 km, West

<br>

b) 7 km, South

<br>

c)8Km, East

<br>

d) 7 km, North

<br>

13. In a party, both chicken and fi were served.

<br>

Some ate only fish and some only chicken.

<br>

Some people were vegetarians who did not eat

<br>

either. The rest of the people ate both chickenand

<br>

fish. Which of the following Venn-diagrams

<br>

Correctly represent this situation ?

<br>

a) D

<br>

b) C

<br>

c) B

<br>

dA

<br>

14. In the given Venn diagram, the circle represents

<br>

•Ph.D. students', the triangle represents Science

<br>

students' and the rectangle represents 'Girls'. The

<br>

numbers given in the shapes represent the number

<br>

of persons of that particular category. How

<br>

many girls are Ph.D. students, but are NOT

<br>

Science students?

<br>

15

<br>

46

<br>

</4

<br>

21

<br>

40

<br>

7

<br>

la

<br>

a) 11

<br>

by 19

<br>

reason.

<br>

c) 20

<br>

d) 27

<br>

15.Consider the following assertion followed by a

<br>

Assertion(A): Diamond is used for cutting

<br>

glass.

<br>

Reason(R): The refractive index of diamond

<br>

is high. Pick out correct option.

<br>

a) BothAand R are true and R is the correct

<br>

explanation ofA.

<br>

b) Both A and R are true, but R is not the

<br>

correct explanation of A.

<br>

c) A is true, but R is false.

<br>

d) A is false, but R is true.

<br>

16. Consider the question given below followed by two

<br>

statement. Analyze the data of both thestatements

<br>

and decide whether the statements are sufficient to

<br>

answer the question.

<br>

Question: When is Deepak's birthday ?

<br>

Statement: (I) Deepak's mother was born on 22

<br>

May, 1970.

<br>

Statement: (II) Deepak is 28 years younger than

<br>

his father.

<br>

a) Statement (1) alone is sufficient, but statement

<br>

(II) alone is not sufficient.

<br>

b) Statement (II) alone is sufficient, but statement

<br>

(I) alone is not sufficient.

<br>

c) Both the statements () and (l) are needed.

<br>

d)Neither statement () nor statement (II) is

<br>

sufficient.

<br>

17.Consider the following statement followed by two

<br>

assumptions.

<br>

Statement: If it is easy to become a doctor,

<br>

then I don't want to be a doctor.

<br>

Assumptions:

<br>

(I) A candidate wants to be professional.

<br>

(II) One wants to achieve a thing which is hard

<br>

earned.

<br>

In view ofthe above, which of the following

<br>

assumptions is implicit ?

<br>

a) Only assumption ([)

<br>

b) Onlyassumption (Il)

<br>
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c) Both the assumptions () and (1)

<br>

d) Neither assumption () nor assumption ()

<br>

18. Consider the statement given below followed by

<br>

two courses of action. You have to assume

<br>

everything in the statement to be true and based of

<br>

the information given in the statement, decide

<br>

which of the suggested courses of action

<br>

logically follow(s) for pursuing.

<br>

Statement: People residing in some rural areas

<br>

do not get fair opportunities of education.

<br>

Courses of action:

<br>

(1) Government should open more schools in

<br>

rural arcas.

<br>

(I) Awareness programme must be conducted in

<br>

these areas.

<br>

Assuming the statement to be true and based

<br>

on the information given in the statement,

<br>

choose which of the suggested courses of

<br>

action logically follow(s) for pursuing.

<br>

a) Only () follows

<br>

bOnly (I) follows

<br>

c)Both (I) and (I1) follow

<br>

d) Neither (I) nor (II) follows.

<br>

19. Consider the following passage.

<br>

"One of the important humanitarian by-products of

<br>

technology is the greater dignity and value that it

<br>

imparts tohuman labour. In a highly industrialized

<br>

society, there is no essential differcnce betwecn

<br>

Brahmin and Dalit, Muslim and Hindu; they are

<br>

equally useful and hence equally valuable for in the

<br>

industrial society. Individual productivity fixes the

<br>

size ofthe paycheque and this fixes social status."

<br>

The passage best supports the statement that:

<br>

a) Technology decides individual's social

<br>

status.

<br>

b) Castes and religions are man-made.

<br>

c) Allindividuals, irespective of caste and

<br>

crecd, are born equal.

<br>

d) Human labour has dignity and value.

<br>

20. Consider the following statement followed by

<br>

two arguments.

<br>

Statement: Should India make efforts to

<br>

harness solar energy to fulfil its energy

<br>

requirements ?

<br>

Arguments:

<br>

a)

<br>

() Yes. Most of the energy sources used at

<br>

present is exhaustible.

<br>

a Only argument () is strong.

<br>

b) Only argument (|1) is strong.

<br>

b)

<br>

(II) No. Harnessing solar energy requires a l

<br>

of capital, which India lacks in.

<br>

c) Neither argument (1) nor argument (II) is

<br>

strong.

<br>

Select which of the arguments is a 'strong'

<br>

argument and which is a 'weak' argument.

<br>

d) Both the arguments ()) and (1) are strong.

<br>

21. Consider the given statements followed by the

<br>

conclusions.

<br>

b)

<br>

Statement (A): Some lions are bats.

<br>

Statement (B): Some bats are cat.

<br>

Conclusion (I): All lions are cat

<br>

Conclusion (|l): No cat are bats.

<br>

Choose the correct answer from the options

<br>

given below.

<br>

Only () follows.

<br>

Only (II) follows.

<br>

c) Both (l) and (II) follow.

<br>

d)Neither (I) nor (I) follows.

<br>

22.Choose the correct option which logically

<br>

follows from the following statement.

<br>

Statement: Many offices are located in

<br>

buildings with multiple floors. If a building

<br>

has morethan three floors, it has a lift.

<br>

a) Allfloors ofbuildings with multiple floors

<br>

may be reached in lifts.

<br>

Only floors above the third floor have lifts.

<br>

c) Seventh floor does not have lifts.

<br>

d)Afl buildings have lifts.

<br>

23.There are eight persons P, Q, R, S, T, U, V and

<br>

W sitting-in a row (not necessarily in the same

<br>

order) and facing east. T is sitting fourth to the

<br>

right of Q. V issitting third from theright end

<br>

of therow. Q is sitting between U and W who is

<br>

sitting third to the left of T who is sitting at a

<br>

corner. P is sitting immediate left of U. R is

<br>

sitting at the left corner of the row.How many

<br>

people are sitting to the right ofN?

<br>
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a) 1

<br>

b) 2

<br>

d) 5

<br>

24. Consider the following information.

<br>

1. M$N means M is the mother ofN.

<br>

2. M#N means M is the father ofN.

<br>

3. M@Nmeans M is the husband ofN.

<br>

4. M % N means M is the daughter of N.

<br>

Which of the following expressions indicate

<br>

"R is thesister ofH"

<br>

a) R % D@FSH

<br>

b) H$D@ F#R

<br>

c) R$D @ F # H

<br>

d) R$F#D % H

<br>

25.Choose the correct answer figure in which

<br>

question figure is embedded.

<br>

Queston Figure

<br>

a) (c)

<br>

b) (d)

<br>

d) (b)

<br>

(a)

<br>

Answer Figures

<br>

(b)

<br>

Problem Figures

<br>

(C)

<br>

26. Select a figure from amongst the Answer figures

<br>

which. will continue the same

<br>

established by the problem figures.

<br>

Answer FigurGs

<br>

(d)

<br>

4

<br>

series as

<br>

a) 1

<br>

b) 2

<br>

c) 3

<br>

27. Find out the correct answer figure that should

<br>

come next in the sequence of problem figures.

<br>

1

<br>

b) 2

<br>

c) 3

<br>

d) 4

<br>

Problem Figures

<br>

28. Find out missing figure (?) in the problem

<br>

figures from the given answer figures.

<br>

Answer Figures

<br>

a) 1

<br>

by 2

<br>

c) 3

<br>

d) 4

<br>

1

<br>

Prob!9m Figures

<br>

Problem Figure

<br>

A

<br>

Answer Figures

<br>

A

<br>

B

<br>

29. Choose the mirror image of the problem figure

<br>

from the answer figures, if the mirror is placed

<br>

to the right of the problem figure.

<br>

Answer Figures:

<br>

3

<br>

?

<br>
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a) D

<br>

b) C

<br>

c) A

<br>

y B

<br>

30. Whatis the horizontal mirror image of the

<br>

word REST?

<br>

REST

<br>

a) B

<br>

c) D

<br>

d) A

<br>

A

<br>

R

<br>

CURRENT AFFAIRS

<br>

31. Who is the New Chief Minister of

<br>

Maharashtra?

<br>

a Šhri Devendra Fadanvis

<br>

b) Shri Eknath Shinde

<br>

c) Shri Ajit Pawar

<br>

d) Shri Uddhav Thackeray

<br>

32. Chief Minister of Odisha presented

<br>

supplementary budget for 2024-25 in OLA

<br>

in November, 2024. How much was the

<br>

amount involved?

<br>

c)

<br>

a) Rs.l2,156 crore

<br>

b) Rs.14,156 crore

<br>

Rs.6,156crore

<br>

d) Rs.18,156 crore

<br>

33. Cyclone Fengal ( hit November) primarily

<br>

affected which States / Countries.

<br>

a) Puducherry, Tamilnadu and Srilanka

<br>

b) Gujarat and Maharashtra

<br>

c) Thailand and Malaysia

<br>

d) Vietnam and China

<br>

34. World Half Marathon record was broken

<br>

recently at Valentia HalfMarathon. Who

<br>

is the new record holder ?

<br>

a) Daniel Mateiko

<br>

b) IsaiaK Lasoi

<br>

c) YomifKejelcha

<br>

d) Jacob Kiplimo

<br>

35. Zimbabwe created new record for highest

<br>

T20 total in October, 2024. What isthe

<br>

new record ?

<br>

a) 344 Runs

<br>

b) 314 Runs

<br>

c) 324 Runs

<br>

d) 354 Runs

<br>

36. Australian Government has banned social

<br>

media access to children younger than?

<br>

a) 12 years of age

<br>

b) 14 years of age

<br>

c) 16 years of age

<br>

d) 18 years of age

<br>

37. When is Ayurveda Day celebrated ?

<br>

a) October 29

<br>

b) October 19

<br>

c) October 9

<br>

d) October 24

<br>

38. Who has taken over as Chairman of

<br>

National Commission for Women in

<br>

October, 2024 ?

<br>

a) Ms Mamta Sharma

<br>

b) Shri Vijaya Kishore Rahatkar

<br>

c) Ms Rekha Sharma

<br>

d) Ms Lalitha Kumar Mangalam

<br>

39. Who was the elected President of Vietnam

<br>

in October, 2024 ?

<br>

a) To Lam

<br>

b) Vo Thianh Xuan

<br>

c) Luong Cuong

<br>

d) Vo Van Thuong

<br>

40. Prime Minister launched Shahid Madho

<br>

Singh Haath Kharch Yogana “ at Rourkela

<br>

on November, 15. Who was Shahid

<br>

Madho Singh ?

<br>

a) Binjhal Zamindar of Ghess locality of

<br>

Bargarh

<br>

b) A freedom fighter

<br>

c) A close associate of Veer Surendra

<br>

Sai

<br>

d All the above

<br>

41. There havebeen major protests in Georgian

<br>

capital Tbilisi in end November, 2024.

<br>

What has been the reason for protests ?

<br>
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a) Accession to European Union

<br>

b) Food inflation

<br>

c) Election fraud

<br>

d) Energy price rise

<br>

42. Bibek Debroy died recently. In which field

<br>

did he distinguish himself?

<br>

a) Economics

<br>

b) Music

<br>

c) Sports

<br>

d) Theatre

<br>

43. What is Scrub Typhus ?

<br>

a) A disease

<br>

b) A plant

<br>

c) A chemical

<br>

d) A medicine

<br>

44. Who is Vice President elect of USA ?

<br>

a) J.D. Vance

<br>

b) Michael Pence

<br>

c) Niki Haley

<br>

d) Tim Walz

<br>

45. P.M. of Israel sacked the Defence Minister

<br>

in November, 2024. Name the Defence

<br>

Minister ?

<br>

a) Yoav Gallant

<br>

b) Israel Katz

<br>

c) Gideon Saar

<br>

d) Yair Lapid

<br>

46. Which Film received best film award for

<br>

2022 at Odisha State Film awards held in

<br>

November, 2024 ?

<br>

a) Daman

<br>

b) Dalchini

<br>

c) Prativa

<br>

d) Shahid Raghu Sardar

<br>

47. Which country did Chief Minister

<br>

Odisha visit in November 2024 to attract

<br>

foreign investment ?

<br>

a) Indonesia

<br>

b) Singapore

<br>

of

<br>

c) UK

<br>

d) Malaysia

<br>

48. _Shri Samir Dey died in November, 2024. He

<br>

was a Minister in Odisha Government

<br>

during 2000 -2004 and 2004-2009. Which

<br>

portfolio did he hold during 2000-2004?

<br>

a) Food & Civil Supplies

<br>

b) Urban Development

<br>

c) Higher Education

<br>

d) Works

<br>

49. In which city did G20 Summit took place

<br>

in November, 2024?

<br>

a)

<br>

b

<br>

Rome

<br>

Rio De Janeiro

<br>

c) Osaka

<br>

d) Bali

<br>

50. Spanish Prime Minister along with Indian

<br>

Prime Minister launched C- 295 Aircraft

<br>

facility in India recently. Name the Spanish

<br>

Prime Minister ?

<br>

a) Mariano Rajoy

<br>

by PedroSanchez

<br>

c) Jose Maria Aznar

<br>

d) Felipe Gonzalez

<br>

51. Donald Trump defeated Kamala Harris in

<br>

November, 2024 Elections for US President.

<br>

How many Electoral College votes did he

<br>

get?

<br>

a) 226

<br>

b) 312

<br>

c) 274

<br>

d) 294

<br>

52. Who was sworn in as CM of Jammu &

<br>

Kashmir in October, 2024?

<br>

a) Mehbooba Mufti

<br>

b) Farooq Abdullah

<br>

Omar Abdullah

<br>

d) Gulam Nabi Azad

<br>

53. Who is Bina Muduli?

<br>

a) First Bonda woman to get a Ph.D.

<br>

b) First Bonda woman to qualify in

<br>

Odisha Civil Service.

<br>

c) First Bonda woman to qualify NEET.

<br>

d) A Bonda writer.

<br>

54. A number of sports events have been

<br>

dropped out of 2026 Common Wealth

<br>

Games. What is the correct information

<br>

out of the following about the sports

<br>
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events dropped out of 2026 Common

<br>

Wealth Games ?

<br>

a) Cycling, Netball & Cricket

<br>

b) Swimming, Boxing & Cricket

<br>

c) Badminton, Cricket, Hockey, Squash,

<br>

Table Tennis & Wrestling

<br>

d) Weight Lifting, Basket Ball & Cricket

<br>

55. Elon Musk in October, 2024 promised to

<br>

pay to randomly selected person(s) who

<br>

signs his online petition pledging to

<br>

support the first & second amendment of

<br>

US Constitution (free speech and gun

<br>

ownership). How much money was

<br>

promised ?

<br>

a) 1,000 US dollars

<br>

b) 10,000 US dollars

<br>

c) 100,000 US dollars

<br>

d) 1,000,000 US dollars

<br>

56. Which Odisha Leader's 125th birth

<br>

anniversary is being celebrated this ycar

<br>

from 21st November,2024?

<br>

a) Shri Biswanath Das

<br>

b) Shri Nabakrushina Chaudhury

<br>

c) Shri Harekrushna Mahatab

<br>

d) Shri Rajendra Narayan Singhdeo

<br>

57. Shyam Benegal dicd in December, 2024. In

<br>

which field did he distinguish himself?

<br>

a) Literature

<br>

b) Dance

<br>

c) Film Making

<br>

d) Music

<br>

58. Who is the cabinet minister in Union Govt.

<br>

in charge of Ministry of Electronics and

<br>

Information Technology?

<br>

a) Shri Hardeep Singh Puri

<br>

b) Shri Kiren Rijiju

<br>

c) Shri Jyotiraditya M. Scindia

<br>

d) Shri Ashwini Vaishnaw

<br>

59, Who is the cabinet minister in Union Govt. in

<br>

charge of Ministry of Environment, Forest and

<br>

Climate change?

<br>

a) Shri Bhupender Yadav

<br>

b) Shri Gajendra Singh Shekhawat

<br>

c) Shri Kiren Rijiju

<br>

d) Smt. Annpurna Devi

<br>

60. Who has been appointed as the Governor of

<br>

Assam in July 2024?

<br>

a) Shri Lakshman Prasad Acharya

<br>

b) Shri K. Kailashnathan

<br>

c) Ms Anusuiya Uikey

<br>

d) Shri Gulab Chand Kataria

<br>

COMPUTER & INTERNET AWARENESS

<br>

61.Which ofthe following chart types is best

<br>

suited for showing the percentage of different

<br>

parts of a whole chart in MS Excel?

<br>

i.

<br>

a) Line Chart

<br>

62. Which of the following options in Windows

<br>

10 allowS you to uninstall or change installed

<br>

software applications?

<br>

ii.

<br>

b) Bar Chart

<br>

iii.

<br>

c)Píe Chart

<br>

d) Scatter Plot

<br>

a)Control Panel

<br>

63. What are the correct steps to open the mouse

<br>

settings directly in the Windows operating

<br>

system?

<br>

b) Task Manager

<br>

c) Windows Installer

<br>

d) Windows Update

<br>

Press Win + Ito open the Settings

<br>

app directly.

<br>

Navigate to Devices from the

<br>

menu.

<br>

Select Mouse from the given

<br>

options.

<br>

a) i,jiü; ii

<br>

bi, ii, ii

<br>

c) ii, i, iii

<br>

d) ii, ii, i

<br>

64. You want to create a slide that compares

<br>

computers to human beings, Which of the

<br>

following layouts is NOT suitable to

<br>

accomplish this task?

<br>

a) Title and 2-column Text Layout

<br>

b) Blnk layout

<br>

c)Title and text layout

<br>
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65.

<br>

d) Comparison

<br>

A computer system's performance is

<br>

slowing down due to excessive use of

<br>

system resources. Which of the following

<br>

system software tools would be the most

<br>

effective in identifying and resolving the

<br>

issue?

<br>

68.

<br>

a) A work processor to document the

<br>

performance metrics and report findings.

<br>

b) A disk defragmenter to organise

<br>

fragmented files on the hard drive.

<br>

c) A task manager or system monitor to

<br>

analyse running processes and terminate

<br>

those consuming excessive resources.

<br>

d) An antivirus program to scan for remove

<br>

potential malware affecting system

<br>

performance.

<br>

66. In a Windows OS, which of the following

<br>

best describes the function of 'pinned'

<br>

taskbar icons, particularly in relation to the

<br>

Start Menu?

<br>

a) Pinned icons allow programs to launch

<br>

automatically when the system starts.

<br>

b) Pinned icons represent minimised

<br>

programs that are currently running.

<br>

c) Pinned icons provide quick access to

<br>

frequently used applications directly

<br>

from the taskbar.

<br>

d) Pinned icons are shortcuts to

<br>

applications that can only be accessed

<br>

from the Start Menu.

<br>

67. Which of the following generation of

<br>

computers is characterised by the

<br>

introduction of integrated circuits (1Cs) and

<br>

witnessed the transition fromn transistors to

<br>

more compact and reliable components?

<br>

a) First Generation

<br>

b) Second Generation

<br>

)Third Generation

<br>

d) Fourth Generation

<br>

Which of the following steps is the correct

<br>

way to insert a Clip Art picture into a

<br>

PowerPoint slide in MS Office PowerPoint

<br>

2007?

<br>

a) Go to the 'File' tab -> Select Open' -

<br>

> Choose Clip Art'

<br>

b) Go to the 'Insert' tab -> Click on

<br>

Clip Art' > Search for the desired

<br>

image -> Click 'Insert

<br>

c) Right-click on the slide > Select

<br>

Insert Clip Art' from the context

<br>

menu

<br>

d) Go the 'Design' tab -> Select Clip

<br>

Art' >Choose the image to insert

<br>

69. In Microsoft Word,

<br>

displays the

<br>

document as it will appear on the printed

<br>

page, including headers, footers, and

<br>

margins.

<br>

a) Draft view

<br>

b) Web browser view

<br>

c) Print layout view

<br>

d) Outlet view

<br>

70. Which of the following early computing

<br>

machines is most directly associated with

<br>

the concept of stored programs, allowing

<br>

instructions to be stored in the machine's

<br>

memory rather than hardwired into its

<br>

circuitry?

<br>

a) ENIAC

<br>

ii.

<br>

b) UNIVACI

<br>

c) IBM 701

<br>

d) EDVAC

<br>

71. In Windows 10, how can a user customise

<br>

the icons that appear in the System Tray?

<br>

a) Go to Control Panel > Appearance and

<br>

Personalization > Taskbar

<br>

b) Go to Settings > Devices > System

<br>

Tray

<br>

Right-click and select 'icons'

<br>

d) Goto Settings > System >

<br>

Notifications & actions

<br>

72. Which statement is True or False when

<br>

running an application on a Windows

<br>

computer?

<br>

i. A registered user account is

<br>

required to run an application on a

<br>

Windows computer.

<br>

Hypervisor allows multiple virtual

<br>

machines to run on a single

<br>

physical machine, each with its

<br>

operating system and applications.

<br>

a ) True, (ii) True

<br>

(i) True, (ii) False

<br>
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c) (i)False, (ii) True

<br>

d) (i) False, (ii) False

<br>

73. In a Windows OS, which of the following

<br>

features allows users to locate files and

<br>

folders across the system using natural

<br>

language queries and filters such as date

<br>

modified, file type and size?

<br>

a) Cortana

<br>

b) Search Box in File Explorer

<br>

c) Indexing Options

<br>

d) Command Prompt

<br>

74. Which of the following devices serves

<br>

both as an input and an output device?

<br>

a) Keyboard

<br>

b) Monitor

<br>

c)

<br>

Touchscreen

<br>

d) Printer

<br>

75. Which of the following technologies is

<br>

commonly used in high-end monitors to

<br>

provide better colour accuracy and

<br>

viewing angles?

<br>

a) Twisted Nematic (TN) Panels

<br>

b) In-Plane Switching (IPS) Panels

<br>

c) Cathode Ray Tube (CRT) Displays

<br>

d) Digital Light Processing (DLP)

<br>

Technology

<br>

76. Which of the following steps would you

<br>

take to print an MS Excel spreadsheet?

<br>

a) Click on 'File > Open'

<br>

b) Click on File'> 'Print'> Select

<br>

Printer > Click on 'Print'

<br>

c) Press 'Ctrl + S'

<br>

d) Click on 'File'> 'Save As'

<br>

77. Which of the following options allows you

<br>

tocustomise the handouts by adding

<br>

headers, footers and page numbers before

<br>

printing them in MS PowerPoint?

<br>

a) Go to the 'Insert' tab-> Select 'Header &

<br>

Footer' -> Choose 'Handout' to

<br>

customize the options.

<br>

b) Go to the File' tab -> Select 'Print' ->

<br>

Click on 'Handout Master' to customize

<br>

the handouts

<br>

c) Go to the View' tab -> Sclect 'Handout

<br>

Master' -> Customize the layout->Print

<br>

d) Go the 'Design' tab -> Select 'Print

<br>

Setup' -> Customize the handouts

<br>

78, In modern CUPs, which of the followino

<br>

techniques is primarily used to increase

<br>

instruction-level parallelism and improve

<br>

processing efficiency?

<br>

a) Pipelining

<br>

b) Caching

<br>

c) Virtualisation

<br>

d) Hyperthreading

<br>

79. Modern mobile phones and tablets utilise

<br>

specialised operating systems optimised for

<br>

touchscreen interfaces and resource

<br>

constraints.Which of the following statements

<br>

correctly describes a key distinction between

<br>

Android and i0S operating systems in terms

<br>

of software distribution and system

<br>

architécture?

<br>

a) Android supports third-party app stores

<br>

and is based on the open-source Linux

<br>

Kernel, while iOS restricts app

<br>

distribution to the Apple App store and is

<br>

built ona closed-source UNIX

<br>

architecture.

<br>

b) Both Android and iOS are open-source

<br>

operating systems that allow installation

<br>

of apps from multiple sources.

<br>

c) iOS provides full customisation of the

<br>

system interface, while Android is

<br>

restricted to manufacturer-defined

<br>

interfaces.

<br>

d) Android devices exclusively use ARM

<br>

architecture processors, while iOS

<br>

devices are capable of using both ARM

<br>

and x86 architecture processors.

<br>

80. Which function in MS Excel checks for a

<br>

condition and counts the number of values

<br>

that satisfy the given condition?

<br>

a) COUNT

<br>

b COUNTIF

<br>

c) IF

<br>

d) MAP

<br>

81. Which of the following characteristics of a

<br>

computer system is most crucial in enabling

<br>

parallel processing, allowing the computer

<br>
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to

<br>

execute

<br>

simultaneously?

<br>

a) Scalability

<br>

b) Speed

<br>

c) Reliability

<br>

multiple instructions

<br>

d) Concurrency

<br>

82. Which of the following is an example of

<br>

an absolute cell reference in MS-Excel?

<br>

a) A1

<br>

b SAS1

<br>

Zc) A$I

<br>

d) $A1

<br>

83. Which of the following accurately

<br>

describes the main contribution of Ada

<br>

Lovelace to the field of computing?

<br>

a) Inventing the first mechanical computer

<br>

b) Writing the first algorithm intended for

<br>

implementation on a machine

<br>

c) Developing the first commercial

<br>

computer

<br>

d) Creating the first programming

<br>

language

<br>

84. In a Windows OS, which setting allows a

<br>

user to swap the functions of the left and

<br>

right mouse buttons, making the right

<br>

button the primary button for selecting and

<br>

clicking?

<br>

a) Pointer Options

<br>

by Button Configuration

<br>

c) ClickLock

<br>

d) Double-Click Speed

<br>

85. You are working on a document in MS

<br>

Word and want to quickly change the

<br>

alignment of a paragraph to be center

<br>

aligned using the icons below the menu

<br>

bar. Which of the following icons should

<br>

you click to achieve this?

<br>

a) The icon with horizontal lines aligned

<br>

to the left

<br>

b) The icon with horizontal lines aligned

<br>

to the center

<br>

c) The icon with horizontal lines aligned

<br>

to the right

<br>

d) The icon with horizontal lines justified

<br>

86. In the ficld ofcryptography, which of the

<br>

following applications of computers 1s

<br>

essential for ensuring the secure

<br>

transmission of data over a network,

<br>

particularly in the context of quantum

<br>

computing?

<br>

a) Symmetric Key Encryption using

<br>

Classical Algorithms

<br>

b) Asymmetric Key Encryption based on

<br>

RSA Algorithm

<br>

c) Quantum Key Distribution (QKD) for

<br>

Secure Communication

<br>

d) Hash Functions for Data Integrity

<br>

Verification

<br>

87. Which of the following power-sáving

<br>

modes in a Windows OS saves the state of

<br>

open documents and applications to the

<br>

hard disk and then completely powers off

<br>

the computer, allowing for zero power

<br>

consumption üntil the system is turned back

<br>

on?

<br>

a) Sleep

<br>

by Hibernate

<br>

c) Hybrid Sleep

<br>

d) Fast Startup

<br>

88. The contents of the active cell are

<br>

displayed in:

<br>

a) Cell Range

<br>

by formula Bar

<br>

c) Title Bar

<br>

d) Name Box

<br>

89. What does Gutter' refer to in the Page

<br>

Setup settings of the Microsoft Work

<br>

Processor?

<br>

a) Page orientation

<br>

b) Page type

<br>

Pagemargin

<br>

d) Page preview

<br>

90. What does the Performance tab in the

<br>

Windows Task Manager do?

<br>

a) Gives details about currently running

<br>

applications and processes

<br>

b) Gives real-time data on the usage of

<br>

system resources

<br>

c) Gives the history of application usage

<br>

and resource graph

<br>
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d Gives details about startup programs

<br>

and their impact on system boot time

<br>

91. The largest four digit number exactly

<br>

divisible by each of 12, 15, 18 and 27 is:

<br>

a) 9930

<br>

b) 9690

<br>

c)720

<br>

d) 9960

<br>

92. The traffic lights at three different road

<br>

crossings change after every 48 seconds, 72

<br>

seconds and 108 seconds respectively. If

<br>

they all change simultaneously at 8:20

<br>

hours, then at what time will they again

<br>

change simultaneously?

<br>

a)8:27: 12 hrs

<br>

b) 8:27: 48 hrs

<br>

827: 24 hrs

<br>

d) 8:27:36 hrs

<br>

a) 45.09

<br>

ARITHMETIC

<br>

b) 46.09

<br>

c) 47.09

<br>

d) 48.09

<br>

3

<br>

93. The number whose square is equal to the

<br>

difference of thesquares of 75.15 and

<br>

60.12 is:

<br>

a) 90

<br>

b) 92

<br>

c) 94

<br>

d) 96

<br>

4,
2,3

<br>

a) 2 kg

<br>

1e48
42,10K

<br>

94. People in a rally are made to stand in rows.

<br>

If 4 persons are extra in each row, there

<br>

would be 2 rows less. If 4 persons are less

<br>

in each row, there would be 4 more rows.

<br>

The number of persons in the rally are:

<br>

ita)-2 .-4)r4

<br>

2423

<br>

2,
|) 3

<br>

95. In a class with certain number of students,

<br>

if one student weighing 50 kg is added then

<br>

average weight of the class increases by 1

<br>

kg. If one more student weighing 50 kg is

<br>

added, then the average weight of the class

<br>

increases by 1.5 over the original average.

<br>

What is the original average weight of the

<br>

class?

<br>

42

<br>

432

<br>

b) 15 kg

<br>

c) 47 kg

<br>

d) 55 kg

<br>

96. In a two digit positive number, the nt,

<br>

digit is equal to the square of tens dioit

<br>

The difference between the original

<br>

number and the number formed hy

<br>

interchanging the digits is 54.What is 40%

<br>

of the original number?

<br>

s15.6

<br>

b) 37.2

<br>

c) 24

<br>

d) None of these

<br>

97. Six years ago, the respective ratio

<br>

between the ages of Riddhi and her father

<br>

2 at that time was 1:7. The difference

<br>

between the age of Riddhi's father and

<br>

Riddhi is 36 years. What will be Riddhi's

<br>

age 5 year from now?

<br>

a) 13 years

<br>

by17 years

<br>

c) 19 years

<br>

d) 21 years

<br>

on transport is:

<br>

98. A man had a certain amount of money

<br>

with him. He spent 20% of that to buy

<br>

grocery and 5% of the remaining on

<br>

transport, and gifted away 120. If he is

<br>

left with 1,400, then the amount he spent

<br>

a)

<br>

b) 61

<br>

c) 95

<br>

d)

<br>

76

<br>

by 0,5

<br>

80

<br>

a) 9,0

<br>

c) 0,0

<br>

d) 9,5

<br>

12

<br>

99. The seven digit number 876p37q is

<br>

divisible by 225. The values ofp andq can

<br>

be respectively:

<br>

142

<br>

3xy 3*s'

<br>

100. A business man gives 4% discount on

<br>

the marked price and gives 1 article free

<br>

for buying every 15 articles and thus

<br>
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gains 35%. The marked price is

<br>

increased above the cost price by:

<br>

a) 20%

<br>

b) 39%

<br>

c) 50%

<br>

d) 55%

<br>

101.A pond was dug by four men: Nishant.,

<br>

Priyanam, Aniruddha and Rahim. They

<br>

were paid a total of1500 and the money

<br>

is to be shared in the ratio of 1 :2 :2:1

<br>

respectively. What is the share of.

<br>

Nishant and Rahim together?

<br>

a)

<br>

b) 1000

<br>

c)300

<br>

1500

<br>

d) None of these

<br>

102. 11 friends went to a restaurant and

<br>

decided to pay the bill amount cqually

<br>

but 10 of them could pay 60 cach, as a

<br>

result 11" fricnd has to pay 50 extra

<br>

than his share. Find the amount paid by

<br>

him(11h friend):

<br>

a) 105

<br>

b) A10

<br>

d) 120

<br>

103. Running at the same constant rate, 6

<br>

identical machines can produce 2700

<br>

files per minute. At this rate, how many

<br>

files could 10 such machines produce in

<br>

4 minutes?

<br>

a) 648

<br>

b) 1800

<br>

c) 2700

<br>

d) 10800

<br>

20

<br>

on every third day?

<br>

a) 12

<br>

104. E, F and G can do a piece of workin

<br>

20 days, 30 days and 60 days

<br>

respectively. In how many days canE

<br>

do work, if he is assisted by F andG3

<br>

b) 13

<br>

d) 18

<br>

410X(0x

<br>

e 30

<br>

105. Nine taps of samecapacity can fill a

<br>

water tank completely in 20 minutes.

<br>

How many taps of the same capacity are

<br>

required to fillup the same water tank in

<br>

15 minutes?

<br>

a) 10

<br>

b) 11

<br>

c) 14

<br>

15

<br>

a) 3:5

<br>

106. It takes eight hours for a 600 km journey,

<br>

if 120 km of it is done by train and the

<br>

rest is done by car. It takes 20 minutes

<br>

more, if 200 km is done by train and the

<br>

rest by car. The ratio of the speed of the

<br>

train to that of the car is:

<br>

b} 3:4

<br>

c),4:3

<br>

d) 4:5

<br>

107.Two trains running in opposite directions

<br>

b) 2: 1

<br>

cross a man standing on the platform in

<br>

27 seconds and 17 seconds respectively

<br>

and they cross cach other in 23 seconds.

<br>

What is the ratio of their spceds?

<br>

a)3:2

<br>

c) 4:3

<br>

d) 1:2

<br>

a) 2.4 km/hr

<br>

108. A man can row 7: kms an hour in still

<br>

b) 3.4 km/hr

<br>

water and he finds that it takes him twice

<br>

as long to row down the river. The rate

<br>

of the stream is:

<br>

5km/hr

<br>

d) 3.5 km/hr

<br>

|2xs

<br>

10

<br>

a) 10.8 kg

<br>

27

<br>

b) 10.6 kg

<br>

109. How many kgs of Bajra costing R8 per

<br>

kg must be mixed with 36 kg of wheat

<br>

costing 5.40 per kg, so that 20% gain

<br>

many be obtained by selling the mixture

<br>

at 7.2 kg?

<br>

c) 10.4 kg

<br>

d) 9.8 kg

<br>

343

4St3t3t6tn42+H2

<br>

34 xs:4O

<br>

12

<br>
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110.If the annual rate of simple interest

<br>

increases from 10% to 12 %, a man's

<br>

annual income increased by

<br>

principal is:

<br>

a) 45000

<br>

b)š0000

<br>

c) 260000

<br>

d) 65000

<br>

111.At what rate of interest will

<br>

a) 5%

<br>

b) 6%

<br>

10%

<br>

d) 15%

<br>

become 24200 after 2 years when

<br>

interest is compounded annually?

<br>

a) 2010

<br>

b) 2220

<br>

c) 1990

<br>

d)_210

<br>

112. The sum of all possible 3 digit numbers

<br>

formed by digits 3, 0 and 7, using each

<br>

digit only once is:

<br>

a) 17 m

<br>

is the breadth of the room?

<br>

b) 17.5 m

<br>

2

<br>

c)18 m

<br>

d) 18.5 m

<br>

20U00{

<br>

113.A carpet of 90cm wide is to be laid at

<br>

301

<br>

403

<br>

130

<br>

3
10

<br>

4.80/m in a room, which is 10m long.

<br>

The total cost of carpeting is 960. What

<br>

b) 12

<br>

1250. The

<br>

c) 14

<br>

2

<br>

d) 16

<br>

20000

<br>

114. Three pipes D, E, F can fill a tank in 6

<br>

hours. After working at it together for 2

<br>

hours, F is closed and D & E can fill the

<br>

remaining part in 7 hours. The number of

<br>

hours taken by F alone to fill the tank is:

<br>

a) 10

<br>

G2

<br>

20hx0e

<br>

16U0

<br>

3.SWu

<br>

115. In an alloy, the ratio of Aluminiumand

<br>

Copper is 5 :2. If 1.250 kg of Copperis

<br>

mixed in 17 kg 500 g of alloy, then the

<br>

G014

<br>

ratio of Aluminium and Copper in the

<br>

alloy will be:

<br>

a) 1:2

<br>

b)2:1

<br>

c) 2:3

<br>

d) 3:2

<br>

116. A merchant has 1000 kg of brinjals, part

<br>

of which he sells at 8 % profit and the

<br>

rest at 18% profit. He gains 14% on the

<br>

whole. The quantity sold at 18% profit

<br>

is:

<br>

a) 560 kg

<br>

b) 600 kg

<br>

c) 400 kg

<br>

d) 640 kg

<br>

117. 150% of 15 + 75% of 75 =?

<br>

a) 75.75

<br>

b) 281.25

<br>

c) 135

<br>

d) None of these

<br>

b48 min

<br>

118. A class starts at 10 a.m and lasts till

<br>

1.27 pm. Four periods are held during

<br>

this interval. After every period, 5

<br>

minutes are given free to the students.

<br>

The exact duration of each period is:

<br>

a) 42 min

<br>

c) 51 min

<br>

d) 53 min

<br>

b)

<br>

119. Alankar goes 4 km against the current

<br>

of a stream in 1 hour and 2 km along

<br>

the current in 15 min. How long will it

<br>

take him to go 7 km in stationary water?

<br>

a) 1h 15 min

<br>

1 h20 min

<br>

T

<br>

Ylh 10 min

<br>

d) 1h5 min

<br>

22y

<br>

a) 300

<br>

b) 55

<br>

120. The sum of squares of the first ten natuy

<br>

numbers is:

<br>
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385

<br>

d) 380

<br>

DATA INTERPRETATION

<br>

Direction (Ques. Nos 121-124) The following

<br>

pie-chart shows the percentage distribution of the

<br>

expenditure incurred in publishing a book. Study

<br>

the pie-chart and answer the questions based on it.

<br>

Various Expenditures (in percentage) Incurred in

<br>

Publishing a Book.

<br>

Paper Cost

<br>

25%

<br>

Binding

<br>

20%

<br>

a) 15°

<br>

b) 24°

<br>

c) 48°

<br>

d) s4

<br>

a) Rs.36

<br>

Transport

<br>

tion Cost

<br>

121. What is the central angle of the sector

<br>

corresponding to the expenditure incurred on

<br>

Royalty ?

<br>

b) Rs.37.50

<br>

c) Rs.42

<br>

Royality

<br>

d) Rs.44.25

<br>

15%

<br>

10

<br>

Promotion

<br>

Cost 10%

<br>

122. The price of a book is marked 20% above the

<br>

cost price. If the marked price of the book is

<br>

Rs.180, then what is the cost of the paper

<br>

used in a single copy of the book?

<br>

|20 1,0

<br>

Printing

<br>

cost

<br>

20%

<br>

123. If 5, 500 copies of the book are published and

<br>

the transportation cost on them amounts to

<br>

Rs.82, 500, then what should be the selling

<br>

60

<br>

50

<br>

40

<br>

30

<br>

price of the book so that the publisher can ea

<br>

a profit of 25%?

<br>

124. Royalty on the book is less than the printing

<br>

cost by:

<br>

20

<br>

10

<br>

a) Rs. 175

<br>

b) Rs.180

<br>

B

<br>

Direction (Ques.Nos. 125-129) Refer to the

<br>

graph and answer the given questions.

<br>

Percentage profit earned by two companies A

<br>

and B over the six years.

<br>

c

<br>

d) Rs.191.50

<br>

Rs.187.50

<br>

a) 33.33%

<br>

by 25%

<br>

c) 20%

<br>

d) 5%

<br>

2008

<br>

2009

<br>

40

<br>

45

<br>

35

<br>

a) 9: 10

<br>

b) 10: 29

<br>

c) 20: 29

<br>

d) 29:45

<br>

2010

<br>

A

<br>

a) 2 lakhs

<br>

35

<br>

b) 4 lakhs

<br>

50

<br>

2011 -

<br>

c) 4.2 lakhs

<br>

50

<br>

45

<br>

2012

<br>

125. If the income of company B in 2010 and 2011

<br>

were in the ratio of2 :3, respectively, then what

<br>

was the respective ratio of expenditures of that

<br>

company in these two years ?

<br>

30

<br>

40

<br>

2013

<br>

126.If the expenditure of companies A and B in

<br>

d) Cannot be determined

<br>

40

<br>

2013 were equal and the total incomes of the

<br>

two companies was 5.7 lakhs. Then what was

<br>

the total expenditure of the two companies in

<br>

2013?

<br>

45

<br>

127. Total expenditure of company A in all the years

<br>
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together was 82.5 lakhs. What was the total

<br>

income of company A in all the years together?

<br>

a) Insufficient data

<br>

b) 1.23 crores

<br>

80%

<br>

c) 98.75 crores

<br>

128. The ratio of expenditures of companies A and

<br>

B in 2012 was 3:4, respectively. What was

<br>

the respective ratio of their incomes in 2012?

<br>

45%

<br>

d) 99.85 crores

<br>

a). 13: 14

<br>

b) 14: 13

<br>

129. Expenditure of company B in 2009 and 2010

<br>

are 12 lakhs and 14.5 lakhs, respectively.

<br>

What was the total income of conmpany B in

<br>

2009 and 2010 together?

<br>

c) 21: 26

<br>

d) 39:56

<br>

a) 39.75 lakhs

<br>

b) 37.95 lakhs

<br>

Direction (Ques. Nos. 130-132) The bar graph

<br>

given below shows the annual result ofdifferent classes

<br>

of a school. Study the graph carefully and attempt the

<br>

question that follow.

<br>

c) 38.75 lakhs

<br>

d) 38.55 lakhs

<br>

80%

<br>

70%

<br>

40°%

<br>

50%

<br>

90%

<br>

b) V-VI

<br>

c)ÍVII

<br>

d) II-IV

<br>

70%

<br>

80%

<br>

Girls

<br>

55%

<br>

80%

<br>

50%

<br>

Boys

<br>

V

<br>

70%

<br>

50%

<br>

VII

<br>

130. In which of the following classes pass

<br>

percentage of girls is less than the average

<br>

pass percentage of the school?

<br>

131. Average pass percentage of the boys in classes

<br>

180

<br>

175

<br>

170

<br>

132. Result of which class shows maximum

<br>

difference between pass percentage of the girls

<br>

and theboys?

<br>

165

<br>

160

<br>

155

<br>

II and III is equal to average pass percentage

<br>

of the girls in which of the following

<br>

classes?

<br>

Direction (Ques. Nos. 133-136) The bar graph

<br>

given here represents the number of persons killed

<br>

in road accidents during rainy season in the year 2009.

<br>

Study the graph carefullyand answer the questions

<br>

that follow:

<br>

150 t

<br>

145

<br>

142

<br>

140

<br>

a) II-VI

<br>

b) I-V

<br>

30

<br>

June

<br>

N-VII

<br>

d) V-VI

<br>

b) II

<br>

c) IV

<br>

d) VI

<br>

7

<br>

14

<br>

July

<br>

21

<br>

Weeks

<br>

a) 4h August - 11h August

<br>

b) 14th July-21 July *

<br>

30th June - 7h July

<br>

d) 21 July - 28h July

<br>

28.

<br>

133. During which of the following successive

<br>

weeks the number of persons killed was the

<br>

highest ?

<br>

a) 28h July - 4h August

<br>

b)th July - 14th July

<br>

c) 30th June -7thJuly

<br>

d) 21 July - 28h July

<br>

4

<br>

11

<br>

August

<br>

1O14 2

<br>

134. During which of the following successive weeks

<br>

the number of persons killed came down to a

<br>

minimum level ?

<br>
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135. In how many weeks the number of persons killed

<br>

was less than 150 ?

<br>

136. In how many weeks the number of persons killed

<br>

was more than 150 ?

<br>

Year

<br>

2004

<br>

2005

<br>

a) 1

<br>

2006

<br>

c) 3

<br>

d) 4

<br>

Direction (Ques. Nos. 137-140) The table

<br>

shows the exports of biscuit from a country

<br>

during various years as given in the following table.

<br>

Study the table carefully and answer the questions

<br>

that follows:

<br>

2007

<br>

2008

<br>

a) 1

<br>

EEEEEE

<br>

b) 2

<br>

c) 3

<br>

d)4

<br>

Volume of Exports of Biscuits from a

<br>

Country

<br>

Quantity (in lakh tins)

<br>

a) 100

<br>

b) 16

<br>

100

<br>

at the same level ?

<br>

a) 2004 and 2006

<br>

b) 2006 and 2008

<br>

c) 233

<br>

75

<br>

d) 350

<br>

150

<br>

2007

<br>

is:

<br>

160

<br>

2006and 2007

<br>

2007 and 2008

<br>

200

<br>

137.During which years the price per tin remained

<br>

Price (in Crores Rs.)

<br>

150

<br>

138. The export price of the biscuits increased from

<br>

2004 to 2008 by how much percent ?

<br>

150

<br>

3SD

<br>

330

<br>

400

<br>

500

<br>

33

<br>

139. The difference between the number of

<br>

biscuits tins exported in 2008 and that in

<br>

a) 40

<br>

b) 40, 000

<br>

c) 4, 00, 000

<br>

d) 40, 00, 000

<br>

140.During which year per tin export price

<br>

remained at highest level ?

<br>

ay 2007

<br>

b) 2006

<br>

c) -2005

<br>

d) 2004

<br>

Direction (Ques. Nos. 141 - 145) Study the

<br>

following pie-charts carefully and answer the

<br>

questions given below:

<br>

Percentage of students enrolled in

<br>

different streams in a' college.

<br>

Total number of students 35e

<br>

1os0

<br>

165

<br>

Arts 30%

<br>

31&

<br>

Commerce

<br>

21%

<br>

ay30%

<br>

Percentage break-up of girls enrolled

<br>

in these streams. Out of the total

<br>

students, total number of girls =1500.

<br>

b) 47%

<br>

c) 60%

<br>

IT 20%

<br>

Managerm

<br>

12

<br>

d) 75%

<br>

2

<br>

gemen)

<br>

Commerce

<br>

12%

<br>

Science

<br>

22%

<br>

IT 18%

<br>

141. The number ofgirls enrolled in Arts, Science,

<br>

and Commerce form what percent ofthe total

<br>

number of students in the college ?

<br>

120

<br>

Arts 38%

<br>

240

<br>

12

<br>

12

<br>
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142. If 20% of the girls enrolled in Science change

<br>

their stream to Management, then what will be

<br>

the new number of Management students

<br>

altogether?

<br>

a) 453

<br>

b) $93

<br>

c) 733

<br>

143. What is the total number of girls enrolled

<br>

in Science and Commerce.together ?

<br>

a) 345

<br>

d) 1003

<br>

S

<br>

b) 450

<br>

c) 480

<br>

144. What is the ratio of the number of girls

<br>

enrolled in Arts to the number of boys

<br>

d) 495

<br>

T

<br>

enrolled in Science ?

<br>

a) 2:3

<br>

b) 14:23

<br>

c) 53: 65

<br>

145. What is the total number of boys enrolled in

<br>

Management and IT together ?

<br>

a)810

<br>

)H4: 121 xy

<br>

b) 980

<br>

c) 1050

<br>

d) 1120

<br>

Direction (Ques. Nos. 146-150) Study the

<br>

table carefully and answer the given questions.

<br>

Totalexports of six countries over five years (in

<br>

crore) Profit = Exports-Imports

<br>

Years -

<br>

Country

<br>

1998

<br>

50

<br>

45

<br>

60

<br>

24

<br>

1999

<br>

a) 88.99%

<br>

40

<br>

25

<br>

b) 72.39%

<br>

55

<br>

60

<br>

40

<br>

after decimal).

<br>

2000

<br>

60

<br>

15

<br>

*70

<br>

20

<br>

55

<br>

60

<br>

2001

<br>

45

<br>

50

<br>

90

<br>

15

<br>

100

<br>

75

<br>

2002

<br>

90

<br>

100

<br>

65

<br>

25

<br>

146. What is the percentage increase in the èxport 2

<br>

110

<br>

ofall the countries together during theyear

<br>

1999 to 2001 ? (rounded off to two di

<br>

120

<br>

c38.899%

<br>

Já) 62.89%

<br>

147.By what percent is the average export of

<br>

country T over allthe given years more than

<br>

the average export of country R over all the

<br>

given years ?

<br>

a) 13%

<br>

11

<br>

b) 91 %

<br>

1

<br>

) 13 %

<br>

148. If the export of country P in the year 2003 is

<br>

20% more than the total export of country Q

<br>

in 2001 and the export of country T in 2000

<br>

together, then what was the profit of P in the

<br>

year 2003, if its import was 92 crore for

<br>

that year ?

<br>

a) 10crores.

<br>

b) 22 crores.

<br>

c) 34 crores.

<br>

d) 46 crores.

<br>

149. If the ratio of export to import in country S and

<br>

country Uis 1:2 and 4: 1 in the year 1998, then

<br>

what is the total import of country U and S

<br>

together in that particular years?

<br>

a) 44 crores.

<br>

b) 52 crores.

<br>

c)

<br>

c) 92 crores.

<br>

d) 96 crores.

<br>

150. What was the profit of all the countries

<br>

together in the year 2002, if the total imports

<br>

ofallthe countries together was 385 crores

<br>

a) 125 crores

<br>

b) 160 crores.

<br>

200 crores.

<br>

d) 240 crores.

<br>
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